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Abstract 

Communication is an integral part of man without which it will be practically impossible for man to achieve 

anything meaningful in life. It is a fact that most 21st century organizations have a network of computers in place, 

however majority of these organizations have not fully utilize the facilities available to them on their network. In 

this paper, we present the implementation of VoIP, desktop sharing, virtual team, file sharing, life chat and internal 

memo transmission on a network of personal computers using Microsoft NetMeeting to reduce the cost associated 

with internal communication within an organization. 
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I TRODUCTIO  

Every innovative success recorded by man since 

creation could be traced to effective communication, 

failure in the building of Tower of Babel could be 

attributed to lack of effective communication (Genesis 

11: 7). Therefore, effective communication is essential 

in any organization, institution or establishments for 

any meaningful success to be achieved. 

Communications between computers is a major part of 

the PC computing industry. Thanks to the World Wide 

Web (www), no computer user is an island. Either by 

using a modem or a faster technology, virtually all PCs 

can be connected to other computers, enabling them to 

share files, send and receive email, and access the 

Internet (Mueller, 1999). We are in a period of rapid 

advance in the collaboration of computer systems to 

perform a wider range of activity than ever before. 

Traditional computer communications to support 

human-driven remote logon, e-mail, file-transfer, and 

latterly the World-Wide Web are being supplemented 

by new applications requiring increasingly complex 

exchanges of information between computer systems 

and between appliances with embedded computer 

chips (Larmouth, 1999). Some of these exchanges of 

information continue to be human-initiated, such as 

bidding at auctions, money wallet transfers, electronic 

transactions, voting support, or interactive video/audio. 

Others are designed for automatic and autonomous 

computer-to-computer communication in support of 

such diverse activities as cellular telephones (and other 

telephony applications), meter reading, pollution 

recording, air traffic control, control of power 

distribution, and applications in the home for control 

of appliances. Computer communication is virtually 

relevant to all human endeavor and it is as important as 

computer itself. Efforts to make computers 

communicate gave birth to computer networking and 

over the years, networking skills have multiplied and 

so many standards have been developed with respect 

to this concept. Information and communication 

technologies (ICT) discipline is one of the fastest 

growing areas, with related services and applications 

having enormous and almost immediate impact on 

diverse aspects of the modern society, including inter-

human relations, economy, education and 

entertainment (Fortuna and Mohorcic, 2009 and Barile 

and Durso, 2002). A network consists of computers, 

called nodes or stations. The computers are connected 

to, or can communicate with, each other in some ways. 

Nodes run special software for initiating and managing 

network interactions. With the help of networking 

software, nodes can share files and resources (Feibel, 

1996). Local Area Network (LAN) only establishes 

communication link between computers within local 

geographical area. And the types of communication 

that occur on such link established by LAN are 

basically services (communication facilities). A 

network could either be wired or wireless and there are 

three broad categories of computer networks, 

distinguished by geographical extent i.e. Local Area 

Networks (LANs), Metropolitan Area Networks 

(MANs) and Wide Area Networks (WANs). LANs 

connect computer equipment in a single building or 

floor of a building. MANs (MANs) interconnect 
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network users over a campus or metropolitan-sized 

region (Robertazzi, 2000).  

Data Communication 
Data Communications is the transfer of data or 

information between a source and a receiver. The 

source transmits the data and the receiver receives it. 

The actual generation of the information is not part of 

Data Communications nor is the resulting action of the 

information at the receiver. Data Communication is 

interested in the transfer of data, the method of transfer 

and the preservation of the data during the transfer 

process. In Local Area Networks, we are interested in 

"connectivity", connecting computers together to share 

resources. Even though the computers can have 

different operating systems, languages, cabling and 

locations, they can still communicate to one another 

and share resources. The purpose of Data 

Communications is to provide the rules and regulations 

that allow computers with different disk operating 

systems, languages, cabling and locations to share 

resources. The rules and regulations are referred to as 

protocols and standards in Data Communication. The 

three different modes of communication between two 

counterparts identified by Bourasi et, al (2006) are 

interactive, communication mode, batch 

communication mode and mixed mode. 

 

RELEVA T WORK  

Coomber and Blair (1998) established that Microsoft 

NetMeeting has adopted a number of International 

Telecommunications Union (ITU) standards within its 

architecture. The key motivation behind the use of 

such standards is to improve interoperability between 

NetMeeting and similar systems. The two key 

standards that impact on the bandwidth usage 

characteristics are ITU T.120 and ITU H.323. 

Coomber and Blair’s work on Bandwidth Usage of the 

Collaborative Tool using Microsoft NetMeeting v2.0 

showed that NetMeetings software configuration 

options can be used to successfully operate the product 

in the tactical environment at bandwidths as low as 32 

kbps. It also provides information on how to setup a 

data conference to minimize the use of Wide Area 

Network bandwidth.   

Evans article on Microsoft Netmeeting cited several 

cases of studies on information driven companies who 

are actively using NetMeeting. The companies include: 

Dow Chemical, Ford Motors, Northrup-Grumman and 

San Diego State University (Evans, 2007). Dow 

Chemical is taking advantage of the collaborative 

capabilities in Microsoft NetMeeting conferencing 

software to support virtual teams (Gould, 2006). Ford 

Motor Company takes advantage of NetMeeting’s 

powerful tools for effective communication over their 

corporate Intranet. Northrup-Grumman has improved 

the quality of communications and collaboration 

among geographically dispersed team members while 

savings travel costs and time while  San Diego State 

University uses NetMeeting to provide two-way audio 

and video conferencing to simulate a traditional 

classroom setting, with its shared white board, shared 

applications, and chat window supporting real-time 

Web-based instruction.  

Microsoft  etmeeting 

Netmeeting is a VoIP and video conferencing client 

included in many of versions of Microsoft Windows. It 

uses the H.323 protocol, and is interoperable with 

Open H323-based clients such as GnomeMeeting. 

Windows Netmeeting is a copyright of Microsoft 

Corporation developed by DataBeam Corporation. 

NetMeeting is a complete network conferencing 

solution that offers standards-based audio, data, and 

video conferencing functionality. Even without video 

or audio communication, data exchange can occur in 

real time over any IP network (LAN) using industry 

standards for Internet telephony. Data can be conveyed 

via White Board, Chat, Email or through joint 

collaboration and editing of any Windows based 

application document you can imagine. Some of the 

key communication facilities of NetMeeting are 

VoLAN (Voice over LAN, LAN Chat, Remote 

Desktop Sharing, File Transfer / Sharing, Audio/Video 

Conferencing and Virtual Meeting.  

METHODOLOGY 

Implementing  etmeeting On Lan 

Having established through system analysis, that most 

organizations spent a huge amount of money and/or 

waste a lot of time on intra-organizational 

communications like memo distribution, voice 

communication etc. (Olayinka, 2007). We present the 

implementation of Microsoft Netmeeting on Campus 

Area Network in order to enhance information 

dissemination within the campus and reduce to the 

barest minimum or even eliminate the cost on intra-

organizational communication thereby maximizing 

communication facilities on the Network. The 

communication facilities (like VoIP, LAN chat, 

Desktop sharing, File transfer, Netmeeting etc.) were 

implemented on an existing IP based network on the 

university campus by using Microsoft Netmeeting 

from Microsoft Corporation. It is a free software that is 

embedded in Windows operating system and is also 

available on the internet for free download. In order to 

maximize communication facilities on LAN, the need 

to have a very good and effective LAN in place cannot 

be over emphasized. Security and speed of such LAN 

must be outstanding in order to have effective and 

efficient communication using Netmeeting. 

Netmeeting software folder is located in the Program 

Files directory located in the drive that contains the 

Windows operating system. The path is usually 

“C:\Program Files\NetMeeting” where “C” represents 
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the windows operating system drive. Double click the 

‘conf’ icon to launch the Netmeeting setup wizard, 

which will guide you through the installation process. 

During the configuration, the wizard will request for 

your first name, last name, e-mail address, your 

location and comments. The information should be 

supplied accordingly. The setup will also request you 

to test your microphone and speaker for voice 

communication. These settings could be changed after 

the initial configuration by launching the program and 

go to TOOLS –→ OPTIONS from the Netmeeting’s 

menu bar. After a successful configuration, 

Netmeeting can be launched by double clicking its 

icon on the desktop. The resulting Microsoft 

Netmeeting interface window is shown in figure 1.  

VoLA  using  etmeeting 

NetMeeting provides full voice capabilities. The audio 

feature supports microphones and speakers. If you are 

using a microphone and speakers, your voice can be 

either half-duplex (communication between two 

computers where data travels only in one direction at a 

time) or full-duplex (communication between two 

computers where data travels in both directions 

simultaneously). Half-duplex voice allows one person 

to speak at a time. Full-duplex voice allows two people 

to speak simultaneously. Check with the sound card 

manufacturer to determine your sound card 

capabilities. If the organization has a voice gateway 

that can be used to place calls, it might be possible to 

use telephone (like SIP phone) instead of a 

microphone and speakers.  

Audio Settings for VoLA� 

To achieve a quality audio communication over LAN 

there is need to adjust the audio setting. This can be 

via the Tools menu on the menu bar of the Netmeeting 

and click Options. On the Audio tab, make the desired 

changes. (If the computer does not have a sound card, 

the Audio tab is not visible).  If the Enable full-duplex 

audio so I can speak while receiving audio check box 

appears dimmed, your sound card does not support 

full-duplex audio. Auto-gain is a sound card and driver 

feature that automatically adjusts the microphone 

volume. Auto-gain is not available with all sound 

cards. The “Automatically adjust microphone volume 

while in a call” option achieves similar results for 

people whose sound cards do not have the auto-gain 

feature.  

 

Full-Duplex Voice can be disabled from Tools menu 

on the menu bar of the Netmeeting. However, for 

computer with full-duplex capabilities, NetMeeting 

automatically uses it. If you experience poor audio, 

you may want to disable it. If your sound card supports 

full-duplex mode, but the Enable full-duplex audio so I 

can speak while receiving audio check box is not 

available, install or reinstall the full-duplex driver.  

Placing a Call on  etmeeting 

In the Address bar of the Netmeeting, type either the 

computer name or IP address of the computer you 

want to call. It is also possible to type the e-mail 

address to connect another computer.  Then click the 

Place Call button. This will put a call across to the 

computer whose name is specified and when this is 

done and the user at other end accepts the call, voice 

communication can commence.  

LA  Chat on  etmeeting 

Another important communication facility deployed on 

LAN is LAN Chat, it is an interesting feature of 

Netmeeting. Since only two people can have a voice 

connection, chat is useful in a group meeting because 

everyone can participate. Chat is also possible if audio 

device are not available. When someone sends a Chat 

message, the message appears in the Chat window. 

Chat Message Sending 

Launch Netmeeting and click the Chat button to open 

Chat. In Message, type the message you want to send, 

to send the message to everyone, in the Send To, click 

Everyone In Chat or To send a message to just one 

person, in Send To, click the person's name and Click 

the Send Message button to send the Chat message or 

press ENTER to send the Chat message. Fonts used in 

Chat can be changed by clicking the Chat button to 

open Chat, on the View menu, click Options will open 

the OPTIONS dialog box and Under Fonts, click the 

appropriate button, and make the desired changes 

Information display can be changed in the OPTIONS 

dialog box by making desired changes under 

Information display. It is also possible to change the 

message format in OPTIONS dialog box. 

Remote Desktop Sharing On  etmeeting 

Remote desktop sharing is a facility on Netmeeting 

that allows users on the network to share their entire 

system. This gives full access and control to the user. 

To remotely connect to a desktop, Launch the 

Netmeeting, on the Tools menu, click Remote Desktop 

Sharing, and follow the instructions on Remote 

Desktop Sharing Wizard screen. Close the Netmeeting 

and right click the NetMeeting Remote Desktop 

Sharing icon that appears in the status area, and then 

click ‘Activate Remote Desktop Sharing’. If you have 

run the Remote Desktop Sharing Wizard previously, 

the Remote Desktop Sharing Settings dialog box 

opens. You can disable Remote Desktop Sharing, 

change the password, and run the wizard again. It is 

also possible to activate Remote Desktop Sharing on 

the ‘Call’ menu by clicking ‘Exit and Activate Remote 

Desktop Sharing’.  

After setting up Remote Desktop Sharing, two icons 

appear in the status bar the desktop, (i.e. NetMeeting 

icon and NetMeeting Remote Desktop Sharing icon). 

When NetMeeting is closed, the NetMeeting Remote 

Desktop Sharing icon remains in the status bar. The IP 
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address of the remote computer must be known in 

order to remotely log in to it.  

Connecting and Disconnecting Remote Desktop  

To remotely access a computer from another location, 

click the ‘Place Call’ button. ‘Place A Call’ dialog box 

(as shown in Appendix C 1) is launched. In the space 

provided for ‘To’, type the computer name or IP 

address of the remote computer. If the ‘Require 

security for this call’ check box is not selected, click it 

to turn on security because Remote Desktop Sharing 

calls must be secure calls. Enter the Remote Desktop 

Sharing password. And click ‘Call’ to connect the 

remote computer.  To end Remote Desktop Sharing, 

Go to ‘Start’ on the desktop of the computer being 

accessed, and then click ‘Log Off’ or ‘Shut Down’. 

Desktop Sharing is the same as sharing the computer. 

Program Sharing 

Shared programs allow meeting participants to view 

and work on files simultaneously. For example, you 

may have a Microsoft Word document that several 

people need to work on. You can open the document 

on your computer, share it, and then everyone can 

provide their comments directly in the document. Only 

the person who has opened the document is required to 

have the application program on their computer. Other 

participants can work on the document without having 

the application program on their systems. Only one 

person can be in control of a shared program at a time. 

If controllable appears in the title bar of the shared 

program window, the person who shared the program 

has control and is allowing others to work in the 

program. If the mouse pointer has a box with initials, 

then another meeting participant has control of the 

program. All meeting participants can share programs 

during a meeting. The shared programs of each 

participant appear in separate shared program windows 

on the other participants' desktops. 

 

In order to sharing a program, go to the ‘Share 

Program’ button on the Netmeeting window, this will 

invoke the ‘Share Program dialog box’ as shown in 

figure 2. In the ‘Sharing dialog box’ go to the ‘Share 

Program’ button, click the name of the program you 

want to share and click ‘Share’. The shared program 

control can be forwarded on the Control menu of the 

shared program window, click Forward Control, and 

then click a name on the list. This is only possible on 

NetMeeting 3.0 or later. Program sharing can be 

terminated by clicking the Share Program button and 

Sharing dialog box, click Unshare to stop sharing one 

program or Unshare All to stop sharing all programs. 

Figure 1:  Netmeeting Version 3.01 Window 

 

 
Figure 2:  Sharing Dialog Box 

 

DISCUSSIO  

We have shown how Netmeeting can be used as a tool 

to maximize the potentials of a network of computer. 

There is need to properly installed the same version of 

Netmeeting on all systems within the organizational 

network by IT experts, who will ensure that a common 

Netmeeting server is installed for all users for effective 

intra-organizational communication. Our 

implementation using Netmeeting for LAN 

communication offered a great deal of advantages over 

the traditional methods of intra – organizational 

communication which normally attracts additional 

cost. Use of Netmeeting ensures efficient voice and 

data communication, speedy dissemination of 

information within an organization (without the use of 

external storage devices like flash drives) and 

elimination of intra – organizational call cost. 

 

Figure 1:  Netmeeting Version 3.01 Window 
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CO CLUSIO  

This paper has presented the implementation of some 

communication facilities on an existing network of 

computers. Effective communication is essential in any 

organization, hence maximization of communication 

facilities on LAN is timely because with the 

implementation of these communication facilities, the 

cost of communication in any organization will reduce 

drastically and communication will be made better in 

terms of efficiency, effectiveness and reliability.  For 

people who want to be more productive in how they  

conduct business or  take a glimpse on the future of 

business communication, then NetMeeting should be 

explored because it offers a great deal of solution to 

communication issues.  
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